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Assessment: Ge*ng around 

1. Which toolbar holds a few command commands and can be customized. Choose the single best 
answer. 

a. Ribbon 
b. Group 
c. Quick Access 
d. Ruler 

2. Which view gives you access to saving and prinDng, document informaDon and protecDon, and 
other opDons? 

a. Outline 
b. Backstage 
c. Info 
d. OpDons 

Assessment answers: Ge*ng around 

1. Which toolbar holds a few command commands and can be customized. Choose the single best 
answer. 

a. Ribbon 
b. Group 
c. Quick Access 
d. Ruler 

2. Which view gives you access to saving and prinDng, document informaDon and protecDon, and 
other opDons? 

a. Outline 
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Assessment: CreaDng documents 

1. If you click Save in a document you haven’t saved before, the Save As window opens instead. 
True or false? 

a. True 



b. False 
2. What is the keyboard shortcut for selecDng everything in a document? 

a. Ctrl + A 
b. Ctrl + P 
c. Ctrl + S 
d. Alt + E 

3. What is the keyboard shortcut to paste text? 
a. Ctrl + P 
b. Alt + P 
c. Alt + V 
d. Ctrl + V 

Assessment answers: CreaDng documents 
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Assessment: Document views 

1. If you click View Side by Side with more than two documents open, what happens? 
a. You have to choose which other document to view. 
b. Documents are arranged in columns. 
c. Nothing happens. 
d. You can’t; the opDon is grayed out. 

2. Which of these acDons will cause the document to zoom in? 
a. Ctrl + I 
b. Alt + Z 
c. Ctrl + Up Arrow 
d. Ctrl + Mouse wheel forward 

Assessment answer: Document views 

1. If you click View Side by Side with more than two documents open, what happens? 
a. You have to choose which other document to view. 
b. Documents are arranged in columns. 



c. Nothing happens. 
d. You can’t; the opDon is grayed out. 

2. Which of these acDons will cause the document to zoom in? 
a. Ctrl + I 
b. Alt + Z 
c. Ctrl + Up Arrow 
d. Ctrl + Mouse wheel forward 

Assessment: Forma*ng character 

1. HelveDca and Arial are examples of what?  Choose the single best answer. 
a. Font size 
b. Font face 
c. Font effects 
d. Font style 

2. Which of the following are examples of character forma*ng? Select all correct answers. 
a. Font size 
b. Line spacing  
c. Alignment 
d. Font style 

Assessment answer: Forma*ng character 

1. HelveDca and Arial are examples of what?  Choose the single best answer. 
a. Font size 
b. Font face 
c. Font effects 
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2. Which of the following are examples of character forma*ng? Select all correct answers. 
a. Font size 
b. Line spacing  
c. Alignment 
d. Font style 

Assessment: Forma*ng paragraphs 

1. IndenDng is a paragraph a^ribute.  True or false. 
a. True 
b. False 

2. What is it called when the first line of a paragraph is not indented, but the rest of the paragraph 
is indented? 

a. Reverse indent 
b. Inverse indent 
c. Hanging indent 
d. Outdent 

3. Which tab-stop type aligns a decimal point to the stop? 
a. Number stop 



b. Column stop 
c. Ledger stop 
d. Decimal stop 

4. What is the string of repeated characters called that leads up to a tab stop? 
a. Tab leader 
b. Tab line 
c. Tab score 
d. Tab tracer 

5. The Tabs window provides more precision and more opDons than se*ng tabs on the ruler.  True 
or false? 

a. True 
b. False 

6. You can clear an individual tab stop by dragging it down off the ruler. True or false? 
a. True 
b. False 

Assessment answer: Forma*ng paragraphs 
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Assessment: Quick Styles 



1. Both themes and styles can change which two a^ributes? 
a. Font face/color 
b. Font effects 
c. Paragraph spacing 
d. Heading colors 
e. Paragraph alignment 

2. The Document Forma*ng group allows you to change themes, colors, fonts, and paragraph 
spacing individually. True or false? 

a. True 
b. False 

3. What style can apply character and paragraph a^ributes at once? 
a. Linked style 
b. Combo style 
c. Dual style 
d. Charagraph style 

 

Assessment  answers: Quick Styles 

1. Both themes and styles can change which two a^ributes? 
a. Font face/color 
b. Font effects 
c. Paragraph spacing 
d. Heading colors 
e. Paragraph alignment 

2. The Document Forma*ng group allows you to change themes, colors, fonts, and paragraph 
spacing individually. True or false? 

a. True 
b. False 

3. What style can apply character and paragraph a^ributes at once? 
a. Linked style 
b. Combo style 
c. Dual style 
d. Charagraph style 

Assessment: Making lists 

1. Which character do you type at the beginning of a line, followed by Space or tab, to start a new 
bulleted list? 

a. Period (.) 
b. Asterisk (*) 
c. Plus sign (+) 
d. Hyphen (-) 

2. You can use any character from any installed font as a bullet. True or false? 
a. True 
b. False 



3. Which of the following are methods you can use to increase the indent level of (demote) a 
selected list item? Choose all correct responses. 

a. Press Alt + Space 
b. Press Tab 
c. Press Alt + Tab 
d. Click increase Indent on the Home tab 
e. Press space 
e. Charagraph style 

 

 

Assessment answers: Making lists 

1. Which character do you type at the beginning of a line, followed by Space or tab, to start a new 
bulleted list? 

a. Period (.) 
b. Asterisk (*) 
c. Plus sign (+) 
d. Hyphen (-) 

2. You can use any character from any installed font as a bullet. True or false? 
a. True 
b. False 

3. Which of the following are methods you can use to increase the indent level of (demote) a 
selected list item? Choose all correct responses. 

a. Press Alt + Space 
b. Press Tab 
c. Press Alt + Tab 
d. Click increase Indent on the Home tab 
e. Press space 
f. Charagraph style 

 

Assessment: Page layout 

1. Which of the following key combinaDons will insert a page break? 
a. Shih + Enter 
b. Ctrl + Enter 
c. Ctrl + P 
d. Shih +Enter 

2. By default, Word will not hyphenate long words over a line break.  True or false? 
a. True 
b. False 

3. What se*ng prevents the first and last lines of a paragraph from being leh alone on a page? 
a. Changeling control 



b. Line item control 
c. Abandoned line control 
d. Widow/orphan control 

4. What is the minimum width for a column on Word? 
a. 0.25 inches 
b. 0.5 inches 
c. 0.75 inches 
d. 1 inch 

5. SecDon numbers appear on the Status bar by default.  True or false? 
a. True 
b. False 

Assessment answers: Page layout 
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Assessment: Proofing documents 

1. Word always suggests at least one opDon for an incorrect word or phrase.  True or false? 
a. True 
b. False 

2. Which opDon do you choose when you want Word to remember a spelling, even for future 
documents? 

a. Ignore Once 
b. Ignore All 
c. Add to DicDonary 



d. AutoCorrect 
3. What is the feature that can automaDcally replace a combinaDon of common characters with 

other characters or symbols not typically found on your keyboard? 
a. AutoChar 
b. AutoReplace 
c. AutoFormat 
d. AutoCorrect 

4. What feature is responsible for starDng a new numbered list when you start a line with a 
number? 

a. AutoFormat 
b. AutoCorrect 
c. AutoList 
d. AutoNumber 

 

Assessment answers: Proofing documents 

1. Word always suggests at least one opDon for an incorrect word or phrase.  True or false? 
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Assessment: Headers and footers 

1. Which of the following techniques will open the header and footer areas for ediDng? Coose the 
single correct Answer. 

a. Pree Ctrl+H 
b. Press Ctrl+Alt+H 
c. Double-click the header area 



d. Press Ctrl+Alt+F 
2. Page number fields automaDcally update as you add or delete pages.  True or false? 

a. True 
b. False 

3. By default, a header will not print on the first page of a document. True or false? 
a. True 
b. False 

Assessment answers: Headers and footers 
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Assessment: Templates 

1. Every Word document is based on a template.  True or false? 
a. True 
b. False 

2. What is the name of the template that opens when you first start Word?  Choose the one correct 
answer. 

a. Default 
b. Basic 
c. Blank 
d. Normal 

3. Which of the following are file extensions used for Word templates? Choose all the correct 
answers. 

a. .dot 
b. .wtm 
c. .dotx 
d. .wtmx 

 

Assessment answers: Templates 

1. Every Word document is based on a template.  True or false? 
a. True 



b. False 
2. What is the name of the template that opens when you first start Word?  Choose the one correct 

answer. 
a. Default 
b. Basic 
c. Blank 
d. Normal 

3. Which of the following are file extensions used for Word templates? Choose all the correct 
answers. 

a. .dot 
b. .wtm 
c. .dotx 
d. .wtmx 

Assessment: InserDng pictures 

1. Which one of these is stored in a graphics file like other pictures? 
a. Online pictures 
b. Shapes 
c. WordArt 
d. SmartArt 

2. A program window must be open (not minimized) to be captured by Word screenshot command.  
True or false? 

a. True 
b. False 

Assessment answers: InserDng pictures 

1. Which one of these is stored in a graphics file like other pictures? 
a. Online pictures 
b. Shapes 
c. WordArt 
d. SmartArt 

2. A program window must be open (not minimized) to be captured by Word screenshot command.  
True or false? 

a. True 
b. False 

Assessment: Forma*ng pictures 

1. If you crop a picture and then save and close the document, you can sDll recover the whole 
picture when you open the document again.  True or false. 

a. True 
b. False 

2. Which command removes effects and adjustments and returns a picture to its original state? 
Choose the best answer. 

a. Remove Forma*ng 



b. Reset Picture 
c. Change Picture 
d. No Style 

Assessment answer: Forma*ng pictures 

1. If you crop a picture and then save and close the document, you can sDll recover the whole 
picture when you open the document again.  True or false. 

a. True 
b. False 

2. Which command removes effects and adjustments and returns a picture to its original state? 
Choose the best answer. 

a. Remove Forma*ng 
b. Reset Picture 
c. Change Picture 
d. No Style 

Assessment: Picture layout 

1. Which method will preserve aspect raDo when you resize a picture? 
a. Hold down the Shih when you resize it. 
b. Right-click and drag corner handle the side handles. 
c. Drag a corner handle. 
d. Check Lock Aspect raDon on the Format tab. 

2. To be able to drag a picture around more freely, change it Text Wrap se*ng to anything other 
than In Linc with Text.  True or false? 

a. True 
b. False 

3. A picture capDon is grouped with the picture, so if you move one, the other will move.  True or 
false? 

a. True 
b. False 

Assessment answers: Picture layout 
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b. False 

 

Assessment: CreaDng tables 

1. Gridlines show you where table borders are, but they do not print.  True or false? 
a. True 
b. False 

2. Which toll is best for creaDng a table with irregular rows, columns, and cells? 
a. Insert Table window 
b. Draw table tool 
c. Quick Tables 
d. Insert Table grid 

3. The table eraser tool can only be used on tables created with the table drawing tool.  True or 
false? 

a. True 
b. False 

 

Assessment answers: CreaDng tables 

1. Gridlines show you where table borders are, but they do not print.  True or false? 
a. True 
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2. Which toll is best for creaDng a table with irregular rows, columns, and cells? 
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b. Draw table tool 
c. Quick Tables 
d. Insert Table grid 

3. The table eraser tool can only be used on tables created with the table drawing tool.  True or 
false? 

a. True 
b. False 

Assessment: Forma*ng tables 

1. By default, sorDng a table on a column will sort that column, leaving data in the other columns in 
place. True or false? 

a. True 
b. False 

2. To delete a column, select it and press Delete.  True or false? 
a. True 
b. False 

3. Decides the Insert table window, where can you find AutoFit opDons for a table? 
a. Design tab 
b. Table Tool Layout tab 



c. Right-click menu 
d. Table ProperDes 

Assessment answers: Forma*ng tables 
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Assessment: Shapes and text 

1. A text box is a shape with text on it.  True or false? 
a. True 
b. False 

2. How can you access the Format tab? 
a. Select a shape. 
b. Right-click a shape, and click Format Shape. 
c. Press Ctrl+F. 

3. Which two ways can you open the Format Shape pane to have precise control over shape 
effects? 

a. Right-click a shape and click Format Shape. 
b. Click the lower-right hand corner of the Shape Styles group. 
c. Double-click a shape, and click More Layout OpDons. 

Assessment answers: Shapes and text 
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Assessment: SmartArt 

1. Clicking Reset graphics returns a graphic to its original state, immediately aher you’ve inserted it.  
True or false? 

a. True 
b. False 

2. You can apply different styles to individual shapes in a SmartArt diagram. True or false? 
a. True 
b. False 

Assessment: 3D models 

1. You can create 3D models in Word.  True or false? 
a. True 
b. False 

2. How can you rotate a 3D model in three dimensions? Choose the best answer. 
a. Use the arrow keys. 
b. Drag anywhere on the model. 
c. Click, hold, and drag on the arrow icon in the center of the model. 

Assessment answers: 3D models 

1. You can create 3D models in Word.  True or false? 
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c. Click, hold, and drag on the arrow icon in the center of the model. 

 

Level 2 
 

Assessment: Custom themes 

1. What elements of a theme can you customized independently? Choose all that apply. 
a. Colors 
b. Effects 
c. Fonts 
d. Shapes 
e. Styles 

2. How many fonts can be defined in a theme? Choose the best answer. 
a. 1 



b. 2 
c. 3 
d. 4 

3. When you change theme effects, doing so affects any graphical elements that use shape styles. 
True or false? 

a. True 
b. False 

 

Assessment answers: Custom themes 

1. What elements of a theme can you customized independently? Choose all that apply. 
a. Colors 
b. Effects 
c. Fonts 
d. Shapes 
e. Styles 

2. How many fonts can be defined in a theme? Choose the best answer. 
a. 1 
b. 2 
c. 3 
d. 4 

3. When you change theme effects, doing so affects any graphical elements that use shape styles. 
True or false? 

a. True 
b. False 

Assessment: Building Blocks 

1. You can best add page numbers using the Header and Footer galleries. True or false? 
a. True 
b. False 

2. Which ribbon tab has most of the building block galleries? Choose the best answer. 
a. Home 
b. Insert 
c. Design 
d. Reference 

3. Before inserDng a building block, you always need to place the inserDon point where you want it 
to go.  For example, before adding a header building block, you should edit the header. True or 
false? 

a. True 
b. False 

Assessment answers: Building Blocks 
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a. True 
b. False 

2. Which ribbon tab has most of the building block galleries? Choose the best answer. 
a. Home 
b. Insert 
c. Design 
d. Reference 

3. Before inserDng a building block, you always need to place the inserDon point where you want it 
to go.  For example, before adding a header building block, you should edit the header. True or 
false? 

a. True 
b. False 

Assessment: SecDon breaks 

1. You want a full-page graphic in the middle of your document to print in landscape format. 
What’s the best thing to do before changing the page orientaDon? 

a. Insert a Next Page secDon break before the graphic. 
b. Insert a Next Page secDon aher before the graphic. 
c. Insert Next Page secDon breaks before and aher graphic. 
d. Insert ConDnuous secDon breaks before and aher graphic. 

2. There are two secDons in your document: the first has two columns, the second has one column.  
If you delete the secDon break between them, what happens? Choose the best answer. 

a. The whole document will have one column. 
b. The whole document will have two columns. 
c. It depends whether it was a New Page or ConDnuous break. 

3. You can change margins, paper size, or page orientaDon for mulDple secDons at a Dme.  True or 
false? 

a. True 
b. False 

4. Aher creaDng 8 secDons in a document, you unlink secDon 4’s footer and then edit it.  What 
parts of the document are changed? 

a. The headers and footers for secDons 1-4. 
b. The headers and footers for secDons 4-8. 
c.  The footers for secDons 1-4. 
d. The footers for secDons 4-8. 
e. Only secDon 4’s footer. 

Assessment answers: SecDon breaks 

1. You want a full-page graphic in the middle of your document to print in landscape format. 
What’s the best thing to do before changing the page orientaDon? 

a. Insert a Next Page secDon break before the graphic. 
b. Insert a Next Page secDon aher before the graphic. 
c. Insert Next Page secQon breaks before and a[er graphic. 
d. Insert ConDnuous secDon breaks before and aher graphic. 



2. There are two secDons in your document: the first has two columns, the second has one column.  
If you delete the secDon break between them, what happens? Choose the best answer. 

a. The whole document will have one column. 
b. The whole document will have two columns. 
c. It depends whether it was a New Page or ConDnuous break. 

3. You can change margins, paper size, or page orientaDon for mulDple secDons at a Dme.  True or 
false? 

a. True 
b. False 

4. Aher creaDng 8 secDons in a document, you unlink secDon 4’s footer and then edit it.  What 
parts of the document are changed? 

a. The headers and footers for secDons 1-4. 
b. The headers and footers for secDons 4-8. 
c.  The footers for secDons 1-4. 
d. The footers for secQons 4-8. 
e. Only secDon 4’s footer. 

Assessment: Page backgrounds 

1. You can apply mulDple watermarks to a single page.  True or false? 
a. True 
b. False 

2. What fill elect would you use to cover the page in a smooth color transiDon? Choose the best 
answer. 

a. Gradient 
b. Pa^ern 
c. Picture 
d. Texture 

3. If you like, you can create a page border that appears only on the leh and right of the page. True 
or false? 

a. True 
b. False 

4. How can you apply a watermark to a single secDon? 
a. Choose “This SecDon” from the “Apply to” list when you create it. 
b. Make sure the secDon’s header is unlinked from the others. 
c. You can apply a watermark only to the enDre document. 

Assessment answers: Page backgrounds 

1. You can apply mulDple watermarks to a single page.  True or false? 
a. True 
b. False 

2. What fill elect would you use to cover the page in a smooth color transiDon? Choose the best 
answer. 

a. Gradient 
b. Pa^ern 



c. Picture 
d. Texture 

3. If you like, you can create a page border that appears only on the leh and right of the page. True 
or false? 

a. True 
b. False 

4. How can you apply a watermark to a single secDon? 
a. Choose “This SecDon” from the “Apply to” list when you create it. 
b. Make sure the secQon’s header is unlinked from the others. 
c. You can apply a watermark only to the enDre document. 

Assessment: Character styles 

1. You’re creaDng a document in which all employee names are colored and italicized, and you 
decide to do so using a style. What style type should you choose? 

a. Character 
b. Linked 
c. Paragraph 

2. Which method of creaDng a style gives you the most control over the forma*ng included with 
the style? 

a. CreaDng a style by example. 
b. Defining a style from scratch. 

3. When copying text into a document, you want to preserve the font exactly, even if you decide to 
later change themes in the rest of the desDnaDon document.  What paste opDon will take the 
least amount of work? 

a. Keep source forma*ng 
b. Keep text only 
c. Merge forma*ng 
d. Use desDnaDon styles 

Assessment answers: Character styles 

1. You’re creaDng a document in which all employee names are colored and italicized, and you 
decide to do so using a style. What style type should you choose? 

a. Character 
b. Linked 
c. Paragraph 

2. Which method of creaDng a style gives you the most control over the forma*ng included with 
the style? 

a. CreaDng a style by example. 
b. Defining a style from scratch. 

3. When copying text into a document, you want to preserve the font exactly, even if you decide to 
later change themes in the rest of the desDnaDon document.  What paste opDon will take the 
least amount of work? 

a. Keep source formabng 
b. Keep text only 



c. Merge forma*ng 
d. Use desDnaDon styles 

Assessment: Paragraph styles 

1. Paragraph styles cannot be created by example.  True or false? 
a. True 
b. False 

2. Which of the following approaches to creaDng styles in a document makes the most sense? 
Choose the one best answer. 

a. Create the lowest-level heading first and work backwards to the base style. 
b. Create the basic style first and build the heading styles from that. 

3. All styles are associated with the heading level.  True or false? 
a. True 
b. False 

Assessment answers: Paragraph styles 
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Choose the one best answer. 

a. Create the lowest-level heading first and work backwards to the base style. 
b. Create the basic style first and build the heading styles from that. 

3. All styles are associated with the heading level.  True or false? 
a. True 
b. False 

Assessment: Footnotes and endnotes 

1. You insert a footnote or endnote from which ta? 
a. Home 
b. Insert 
c. References 
d. Review 

2. Aher entering an endnote, how can you return quickly to your place in the text?  
a. Right-click the note text, and click Go to Endnote. 
b. Right-click the note number, and click Go to Endnote. 
c. Press Ctrl+G. 
d. Use the Go To funcDon. 

 

Assessment answer: Footnotes and endnotes 
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d. Use the Go To funcDon. 

Assessment: Table of contents 

1. If you don’t use heading styles in a document, you can fill out the table of contents manually. 
True or false? 

a. True 
b. False 

2. Which opDon in the table of Contents window determines what heading levels are shown? 
a. Heading level 
b. Formats 
c. Heading depth 
d. Show levels 
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Assessment: Hyperlinks 

1. Hyperlinks can be applied only to text.  True or false? 
a. True 
b. False 

2. Which methos(s) allow(s) you to create a hyperlink to another locaDon in the same document? 
a. Use the Place in this Document link. 
b. Use ExisDng File or Web Page, then click Target Frame. 
c. Use ExisDng File or Web Page, then click Bookmark. 
d. Use create New Document, then click Bookmark. 
e. Use create New Document, then click Target Frame. 

3. For email addresses, the display text is always the same as the address.  True or false? 
a. True 
b. False 
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Assessment: NavigaDng documents 

1. In the Find and Replace window, which do you click to search for special characters such as 
footnote marks and paragraph characters? 

a. Special 
b. Format 
c. Symbol 
d. Character 

2. Which features allow you to skip through instances of a specified object, such as pictures or 
headings? 

a. Skip To 
b. Go To 
c. Find Object 
d. Hop Along 
e. NavigaDon pane Search box 

3. Which keyboard shortcut opens the NavigaDon pane? 
a. Alt+N 
b. Ctrl+F 
c. Ctrl+N 
d. Alt+F 
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Assessment: Master documents 

1. When you add a subdocument to a master document, the contents is copied to the master 
document, and you no longer need the subdocument.  True or false? 

a. True 
b. False 

2. How do you turn a document into a master document? Select the correct answer opDon. 
a. Save it as a Master Document file type. 
b. On the Insert tab, check Master Document. 
c. On the Outlining tab, insert a subdocument. 
d. In the NavigaDon pane, on the Heading tab, click Add Part. 
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Assessment: Saving and sending 

1. You need a colleague to edit complex document, but his non-Microsoh word processing 
applicaDon can’t reliability read Word default format.  What format would preserve most of your 
current forma*ng opDons while sDll being readable to other applicaDon? 

a. OpenDocument Text 
b. PDF 
c. Rich Text Format 
d. XPs 

2. XPS is naDvely supported by Windows Vista and later.  Ture or false? 
a. True 



b. False 
3. Word is really compaDble only with blogs using Microsoh’s Window Live Spaces format.  True or 

false? 
a. True 
b. False 

4. What should you do if Word opens a document in ProtecDve view? Choose the best response. 
a. ConDnued a normal: Protected view lets  you edit the document safely. 
b. Delete or quaranDne the file: Word has detected malware in it, and it’s unsafe to open. 
c. Disable Protected view if you trust the document source. 
d. Save the document in the default .docx format. 
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Assessment: Comments 

1. What can you do when ediDng a comment? Choose all that apply. 
a. Adjust paragraph se*ngs 
b. Change character size 
c. Change the font 
d. Insert an image 

2. If you want to print a document without showing comments, you have to delete them all.  True 
or false. 

a. True 
b. False 

3. To view an inline comment’s full content, you need to show comments or display the Reviewing 
Pane.  Trye or false. 



a. True 
b. False 
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Assessment: ProtecDng documents 

1. When you mark a document as final, you can specify a password needed to unlock it for ediDng.  
True or false? 

a. True 
b. False 

2. For technical reasons, document encrypDon and ediDng restricDons don’t work well together.  
True or False? 

a. True 
b. False 

3. It’s easy to recognize excepDons in a restricted document.  True or False? 
a. True 
b. False 

4. If you forget a document’s encrypDon password, there’s no easy way to recover it.  True or false? 
a. True 
b. False 
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Assessment: Tables and charts 

1. Which descripDons are true of embedded objects?  Choose all that apply. 
a. They can be edited in the source applicaDon. 
b. They can be copied or shared without worrying about access to external files. 
c. They lead to larger document file sizes than linked objects do. 
d. They lead to smaller document file sizes than linked objects do. 
e. They reflect any changes made to the original file. 

2. What is true of linked objects? Choose all that apply. 
a. They can be edited in the source applicaDon. 
b. They can be copied or shared without worrying about access to external files. 
c. They lead to larger Word document file sizes than linked objects do. 
d. They lead to smaller Word document file sizes than linked objects do. 
e. They reflect any changes made to the original file. 

3. A Word chart is very much like an embedded Excel object.  True or false? 
a. True 
b. False 

4. If you don’t have excel installed, you can use formulas in Word tables.  True or False? 
a. True 
b. False 
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Assessment: CreaDng building blocks 

1. What can’t you do from within the Building Block Organizer? 
a. Delete a building block. 
b. Edit building block’s contents. 
c. Edit a building block’s properDes. 
d. View all your building blocks in one place. 

2. The Building Blocks template is saved in the background without any user interacDon.  True or 
false? 

a. True 
b. False 

3. It’s easy to move a building block from one gallery to another. True or false? 
a. True 
b. False 
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Assessment: Linking content 

1. When you delete a text box in the middle of a story, it splits it into two separate stories.  True or 
false? 

a. True 
b. False 

2. If you unlink a text box, the text that was in it might not be displayed but won’t be erased.  True 
or false? 

a. True 
b. False 

3. If you had a series of five linked text boxes, and broke the link between the second and third, the 
last three would sDll be linked together. True or false? 

a. True 
b. False 
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Level 3 
Assessment: Configuring Word opDons 

1. You probably shouldn’t use stricter se*ngs than the trust Center defaults.  True or false. 
a. True 
b. False 

2. What features can you control in the Proofing secDon of the Word opDons window? Choose all 
that apply.  

a. AddiDonal ediDng languages 
b. AutoCorrect 
c. AutoRecover 
d. Custom dicDonaries 
e. Macro se*ngs 

3. Changes you make in the Word OpDons window might affect other Microsoh Office applicaDons 
such as Excel and PowerPoint. True or false? 

a. True 
b. False 
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e. Macro sebngs 
3. Changes you make in the Word OpDons window might affect other Microsoh Office applicaDons 

such as Excel and PowerPoint. True or false? 
a. True 
b. False 

Assessment: Working with templates 

1. When you a^ach a new template to a document, it doesn’t necessarily change the document’s 
appearance.  True or false. 

a. True 
b. False 

2. What can you do from the Organizer window?  Choose all that apply. 
a. Copy a style between templates. 
b. Copy building blocks between templates. 
c. Delete a custom style. 
d. Delete a template. 

3. The easiest way to modify a template is to create a new document based on it, then save it as a 
template using the same name. True or false. 

a. True 
b. False 
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Assessment: Tracking and reviewing changes 

1. When mulDple users have made tracked changes in a document, they are ____________. 
a. All idenDcal 
b. Displayed in different colors 
c. Displayed in separate panes 
d. Forma^ed differently 

2. Two people have made their own revisions to a document, but neither has tracked changes. How 
can you best consolidate both sets of changes into a new document? 



a. Combine the documents. 
b. Compare the documents. 
c. Compare each document with the original version, then combine the results of each 

comparison. 
d. None of the above; without tracked changes, you have to reconcile them manually. 

3. Even when you hide certain types of markup using the Show Markup opDons, they’ll sDll be 
visible in the Revision pane.  True or false? 

a. True 
b. False 

4. By default, a double-strikethrough indicates that text has been _______. Choose the best 
answer. 

a. Commented upon 
b. Deleted 
c. Moved 
d. Reforma^ed 
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4. By default, a double-strikethrough indicates that text has been _______. Choose the best 
answer. 

a. Commented upon 
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Assessment: Internal references 

1. What is true about bookmark names? Choose all that apply. 
a. They cannot contain spaces. 
b. They cannot contain underscores. 



c. They may begin with a le^er or a number. 
d. They may begin with a le^er. 
e. They may begin with a number. 

2. When you move the full contents of a bookmark, the bookmark itself also moves.  True or false? 
a. True 
b. False 

3. Cross-references are useful, even if you’re planning to print the document.  True or false? 
a. True 
b. False 

4. Unlike an ordinary hyperlink, a cross-reference ____________. Choose all that apply. 
a. Appears as normal text when printed 
b. AutomaDcally updates its text whenever fields are updated. 
c. Can point to a bookmark 
d. Can point to an external document 

Assessment answers: Internal references 

1. What is true about bookmark names? Choose all that apply. 
a. They cannot contain spaces. 
b. They cannot contain underscores. 
c. They may begin with a le^er or a number. 
d. They may begin with a lefer. 
e. They may begin with a number. 

2. When you move the full contents of a bookmark, the bookmark itself also moves.  True or false? 
a. True 
b. False 

3. Cross-references are useful, even if you’re planning to print the document.  True or false? 
a. True 
b. False 

4. Unlike an ordinary hyperlink, a cross-reference ____________. Choose all that apply. 
a. Appears as normal text when printed 
b. AutomaQcally updates its text whenever fields are updated. 
c. Can point to a bookmark 
d. Can point to an external document 

Assessment: Indexing 

1. Word can only create two index levels.  True or false? 
a. True 
b. False 

2. What index type might you use if you have a lot of subentries but space is limited?  Choose the 
best response. 

a. Cross-referenced 
b. Indented 
c. Right-aligned 
d. Run-in 



3. You shouldn’t copy and paste or manually edit index entries, as doing so can interfere with how 
the XE field code works.  True or false? 

a. True 
b. False 
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Assessment: CiDng external sources 

1. The citaDon style you should use depends largely on your subject manner and chosen audience.  
True or false? 

a. True 
b. False 

2. Which of the following statements are true about sources? 
a. Each source must have a unique tag name. 
b. Each source must have a unique Dtle. 
c. Every source you define is stored in a master list on your computer. 
d. MulDple authors must be entered one at a Dme in a separate window. 
e. The file names you’re prompted to enter depend on the type of source. 

3. How can you keep a customized bibliography format? Choose the best response. 
a. Download it from Office.com 
b. Save it as a building block 
c. Save it as a document template 
d. You can’t but must manually edit it for each document. 

4. A Table of AuthoriDes is typically found only in what kind of document? 
a. EducaDonal 
b. HumaniDes 
c. Legal 
d. ScienDfic 
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Assessment: Recipient lists 

1. A recipients list doesn’t allow custom fields, but there are generic fields you can use however 
you like.  True or false? 

a. True 
b. False 

2. You can import a recipient list from a text file.  True or false/ 
a. True 
b. False 

3. Aher customizing an imported address list, you find a misspelled street name.  How can you 
most easily correct it?  Choose the best answer. 

a. Click Validate addresses in the Mail Merge Recipients window. 
b. Edit the data source in its original applicaDon, then repeat the import process. 
c. Edit the file directly in the Mail Merge Recipients window. 
d. Open the data source from within the Mail Merge Recipients window, and edit the field 

there.  Choose the best answer. 
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3. Aher customizing an imported address list, you find a misspelled street name.  How can you 
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c. Edit the file directly in the Mail Merge Recipients window. 
d. Open the data source from within the Mail Merge Recipients window, and edit the 

field there.   

Assessment: Performing mail merge 

1. The Mail Merge Wizard is a very different process than manually performing a mail merge.  True 
or false? 

a. True 
b. False 

2. What should you use to skip a record that matched certain criteria? Choose the best response. 
a. A merge field 
b. A merge filter 
c. A merge match 
d. A merge rule 

3. The process for ediDng a merge field can be used on other types of fields as well.  True or false? 
a. True 
b. False 

4. What happens when you finalize a merge and choose a document output? Choose the best 
response. 

a. Word creates each record as a separate document in the same folder as the original 
document. 

b. Word creates a single new document with each record in its own secDon. 
c. Word inserts each record as a new secDon in the exisDng document. 
d. Word preserves the merge fields, and only finalizes the records once you print the 

document. 
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4. What happens when you finalize a merge and choose a document output? Choose the best 
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a. Word creates each record as a separate document in the same folder as the original 
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b. Word creates a single new document with each record in its own secQon. 
c. Word inserts each record as a new secDon in the exisDng document. 
d. Word preserves the merge fields, and only finalizes the records once you print the 

document. 

Assessment: Envelopes and labels 

1. In general, you need a specialized printer to output envelopes or labels in Word.  True mor false? 
a. True 
b. False 

2. It’s a good idea to define yourself as an Outlook contact, so you can easily insert yourself in the 
Return address field of envelopes. True or false? 

a. True 
b. False 

3. When you create a page of labels, what does Word use to separate individual labels?  Choose 
the best answer. 

a. SecDon breaks 
b. Tab stops 
c. Table cells 
d. Text boxes 

4. When you create a label merge, how does Word separate each record? Choose the best answer. 
a.  An AddressBlock field 
b. A Next Record field 
c. A secDon break 
d. A table cell 

Assessment answers: Envelopes and labels 

1. In general, you need a specialized printer to output envelopes or labels in Word.  True mor false? 
a. True 
b. False 

2. It’s a good idea to define yourself as an Outlook contact, so you can easily insert yourself in the 
Return address field of envelopes. True or false? 

a. True 
b. False 

3. When you create a page of labels, what does Word use to separate individual labels?  Choose 
the best answer. 

a. SecDon breaks 
b. Tab stops 
c. Table cells 
d. Text boxes 



4. When you create a label merge, how does Word separate each record? Choose the best answer. 
a.  An AddressBlock field 
b. A Next Record field 
c. A secDon break 
d. A table cell 

Assessment: Macros 

1. Regardless of how you create a macro, Word stores it as a VBA program.  True or false? 
a. True 
b. False 

2. Which window lets you move macros from one document to another? 
a. Macro 
b. Organizer 
c. Recorder 
d. Visual Basic Editor 

3. What do you need to do to make a macro run whenever you start Word?  Choose all that apply. 
a. Configure the trust Center to allow all macros 
b. Name it AutoExec 
c. Name it AutoOpen 
d. Store it in the default template 
e. Store it in AutoExec.doc 
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Assessment: Forms 

1. Which form controls require document protecDon to funcDon? Choose the best answer. 
a. AcDveX controls 
b. Content controls 
c. Legacy form fields 
d. All the above. 



2. Although they can be selected individually, check-box controls are arranged in groups using tag 
properDes. True or false? 

a. True 
b. False 

3. What kind of control should you use if you want users to either select an exisDng opDon or enter 
a new one? Choose the best answer. 

a. Building Block gallery 
b. Combo Box 
c. Drop=Down List 
d. Tich Text 

4. To export content control form data to a database, you need to use VBA code.  True or false? 
a. True 
b. False 

Assessment answers: Forms 

1. Which form controls require document protecDon to funcDon? Choose the best answer. 
a. AcDveX controls 
b. Content controls 
c. Legacy form fields 
d. All the above. 

2. Although they can be selected individually, check-box controls are arranged in groups using tag 
properDes. True or false? 

a. True 
b. False 

3. What kind of control should you use if you want users to either select an exisDng opDon or enter 
a new one? Choose the best answer. 

a. Building Block gallery 
b. Combo Box 
c. Drop=Down List 
d. Tich Text 

4. To export content control form data to a database, you need to use VBA code.  True or false? 
a. True 
b. False 

 

 

 

 

  

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 


